
 
 
 

 
 
 
 

 

Version  :  3.1.1.5 
Revision  : 1 
 
Website  :  www.kayako.com 
Forums  :  http://forums.kayako.com  
Support  :  http://support.kayako.com 
 
Editorial  : docs@kayako.com 

 
 
 
 
 

Kayako SyncWorks  
 

User Manual 
 



  [ 2 ] 
 

About this manual 

This version of the manual can be used as a guide for many other proceeding and proceeding 
versions of Kayako InstaAlert. However, please note that feature discrepancies may exist between 
versions. 
 
We publish a new and up to date manual upon the release of each stable build. For accuracy, be 
sure to use the manual(s) bundled with your downloaded SupportSuite package. 
 
If you would like to send in a suggestion or report any errors in this manual, please send an e-mail 
to docs@kayako.com or post in the documentation forum - your input is very much appreciated. 
Please do not use this address for support. 
 
You can obtain further support for any of Kayako’s products via: 
 

• Support desk – www.kayako.com/support 
 

• Community forums – http://forums.kayako.com 
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Introduction to Kayako SyncWorks 

Kayako SyncWorks is an application for Microsoft Office Outlook (Microsoft® Corporation) that 
communicates with your installation of SupportSuite, eSupport or LiveResponse, synchronizing 
events, appointments, tasks and contacts with your installation of Outlook. 
 
SyncWorks operates entirely within Outlook. 
 
SyncWorks can also be used in conjunction with Kayako LiveResponse Client Application SIP 
Addon, and can be used to import Outlook contacts into the SIP addon’s VoIP phone. 
 
SyncWorks can be configured to alert you in a variety of ways, including:  
 

• Automatic synchronization. 
• Selective synchronization – choose which items to synchronize and which way. 
• Action permissions (can events deleted in SupportSuite be deleted in Outlook?). 
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SyncWorks feature list 

 
 
Above: SyncWorks’ synchronization options dialog. 
 

• Synchronizes data between your SupportSuite, eSupport or LiveResponse and your Outlook 
installation. 
 

o Calendar events and appointments. 
o Contacts and address book. 
o Task list. 

 
• Maintain item privacy (if an item is marked as private in Outlook, the tem will be marked as 

private to your user account in SupportSuite, eSupport or LiveResponse). 
 

• Configure specific synchronization options. 
 

o Such as, synchronize one way or both ways (mirror or synchronize). 
o Select which items to synchronize. 
o Select whether deletions should be synchronized. 

 
• Connect via a network proxy. 

 
• Automatic synchronization on Outlook startup. 

 
• Automatic synchronization at specified regular intervals. 
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Downloading SyncWorks 
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Locating the SyncWorks set up files 

This SyncWorks set up files can be found in the archive of SupportSuite, eSupport or 
LiveResponse that is available for downloaded from the member’s area 
(http://members.kayako.net), as shown below. 
 

 
 
The SyncWorks setup files will be found in the folder \syncworks\ of the .tar.gz archive, as shown 
below. 
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Getting the latest version 

The latest stable version of InstaAlert can be downloaded from http://hotfix.kayako.com. It is 
recommended you download a copy from this location, so that you can be sure you have the most 
up-to-date release. 
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Installation Guide 
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Step one 

After downloading the latest version of the SyncWorks software, run Setup.exe. This will bring up a 
window similar to the following. 
 

 
 
Press the Next button to continue. 
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Step two: License agreement 

 
 
Review the license agreement and accept the terms as appropriate.  
 
Press Install to proceed with the installation. The InstaAlert program files will now be installed onto 
the system and configured. This process is automatic. 
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“Outlook is already running” error 

 
 
If you receive the error above, it means that Outlook is either running or is running in the 
background. 
 
To check if Outlook is running in the background, launch the task manager (press the CTRL + ALT 
+ DEL keys simultaneously) and search for the process OUTLOOK.EXE. If you find it, select the 
process and click on the End Process button. 
 
Go back to your error message and click on the Retry button. The installation should proceed as 
normal. 
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Step three: Completion 

After the automatic installation procedure has completed successfully, the first time setup guide will 
launch (see first-time configuration guide). 
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First-time Configuration Guide 

The first-time configuration process is a procedure that you are taken through following the first run 
of the SyncWorks program. The wizard will take you through the basic configurations required to get 
SyncWorks up and running. 
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Step one 

If this is the first time you have run SyncWorks, you will be presented with the first screen of the 
first-time setup wizard. This wizard will guide you through the steps necessary to customize the 
installation and connect and begins synchronizing to your eSupport or SupportSuite installation. 
 

 
 
Click on the Next button to continue. 
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Step two: Authentication details 

 
 

1. Server URL – this is the location of the SupportSuite, eSupport or LiveResponse  installation. 
If you have installed the support software at http://www.joeblogs.com/support/, then enter 
this as the Server URL. 

 
The Server URL should not be the URL of your staff or admin control panel. It should be the 
location in which you have installed eSupport or SupportSuite – i.e. the location to which your users 
browse to in order to access your support desk. 
 

2. User Name – this is your username and password that you use to login to the staff control 
panel of the SupportSuite, eSupport or LiveResponse installation. 
 

3. Password – this is the password you use in conjunction with your username as detailed 
above. 

 
Click on the Next button to continue. 
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Step three: Synchronization settings 

 
 

• Automatically synchronize on Outlook startup – if enabled, SyncWorks will automatically 
synchronize with your server on startup. 
 

• Close synchronization window after successful synchronization – if enabled, the 
successful synchronization window will be closed rather than remain opened. 
 

• Automatically synchronize data every X minutes – if enabled and specified, SyncWorks 
will automatically synchronize with your server at the specified interval.  
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• Synchronize data from Outlook to Server – if enabled, data stored in your Outlook 
installation will be uploaded and synchronized to your SupportSuite, eSupport or 
LiveResponse installation.  
 

o Contacts 
 

 Synchronize Contacts - if enabled, contacts added or modified in Outlook will 
be added or modified on your server. 
 

 Delete Contacts – if enabled, contacts deleted in Outlook will also be deleted 
from the server installation. 
 

 Make Contacts Private – if enabled, contacts made private in Outlook will be 
made private to your staff user account in SupportSuite, eSupport or 
LiveResponse. 
 

o Tasks 
 

 Synchronize Tasks - if enabled, tasks added or modified (such as marked as 
complete) in Outlook will be added or modified on your server. 
 

 Delete Tasks – if enabled, tasks deleted in Outlook will also be deleted from 
the server installation. 
 

 Make Contacts Tasks – if enabled, tasks made private in Outlook will be 
made private to your staff user account in SupportSuite, eSupport or 
LiveResponse. 
 

o Appointments  
 

 Synchronize Appointments - if enabled, appointments added or modified 
(such as having the date changed) in Outlook will be added or modified on 
your server. 
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 Delete Appointments – if enabled, appointments deleted in Outlook will also 
be deleted from the server installation. 
 

 Make Contacts Appointments – if enabled, appointments made private in 
Outlook will be made private to your staff user account in SupportSuite, 
eSupport or LiveResponse. 
 

 
• Synchronize data from Server to Outlook - if enabled, data stored in your SupportSuite, 

eSupport or LiveResponse installation will be downloaded and synchronized with your Outlook 
installation. 
 

o Each option following is the same as above, but the reverse (instead of Outlook -> 
Server,  Outlook <- Server). 

 
Click on the Next button to continue. 
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Step four: Language 

 
 
Which language pack SyncWorks will use is specified here.  
 
By default, the only language pack for InstaAlert bundled with the installation files is the default 
English (U.S.) language file. 
 
Press the Finish button to complete the configuration and start using SyncWorks.  
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SyncWorks toolbar 

 
 
The SyncWorks toolbar should become automatically available within Outlook, as shown above.  
 
If it is not, to make the toolbar available: 
 

1. Click on the View menu. 
 

2. Click on the Toolbars menu. 
 

3. Click on Kayako SyncWorks. 
 

To perform an immediate synchronization, click on the Synchronize  button on this 
toolbar. 
 

To open the SyncWorks menu, click on the SyncWorks menu  button on this toolbar. This 
will open the SyncWorks menu, as shown below. 
 

 
 

• Event Log – open the SyncWorks event log (see event logger). 
 

• Staff CP – open the SupportSuite, eSupport or LiveResponse staff control panel in your 
default web browser. 
 

• Options – open the SyncWorks options dialog (see configuration and options). 
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Performing a synchronization 

To perform a synchronization: 
 

1. Click on the Synchronize button on the SyncWorks toolbar, as shown below. 
 

 
 
Synchronization will begin immediately, with progress shown in a window as shown below. 
 

 
 
If synchronization is unsuccessful, the error message will be displayed in this window. Likewise, if 
synchronization is successful the success message will be shown here unless automatic closure after 
successful synchronization has been enabled (see general options).  
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Configuration and options 

The options dialog is accessible by following these steps:  
 

1. Click on the SyncWorks menu on the SyncWorks toolbar, as shown below. 
 

 
 

2. Click on the Options menu choice. 
 
This will open the options dialog, as shown below. 
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General 

 
 
Authentication 
 

• Server URL – this is the location of the SupportSuite, eSupport or LiveResponse  installation. 
If you have installed the support software at http://www.joeblogs.com/support/, then enter 
this as the Server URL. 

 
The Server URL should not be the URL of your staff or admin control panel. It should be the 
location in which you have installed eSupport or SupportSuite – i.e. the location to which your users 
browse to in order to access your support desk. 
 

• User Name – this is your username and password that you use to login to the staff control 
panel of the SupportSuite, eSupport or LiveResponse installation. 
 

• Password (click on the button) – this is the password you use in conjunction with your 
username as detailed above. 

 
 
Auto Synchronization 
 

• Automatically synchronize on Outlook startup – if enabled, SyncWorks will automatically 
synchronize with your server on startup. 
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• Automatically synchronize data every X minutes – if enabled and specified, SyncWorks 
will automatically synchronize with your server at the specified interval. 
 

• Automatically close synchronization window after success – if enabled, the successful 
synchronization window will be closed rather than remain opened. 
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Network 

 
 
If connection to your eSupport or SupportSuite installation through a proxy is required, the proxy 
settings can be enabled and configured here. 
 
Normally, users operating from a regular home or office network need not configure any proxy 
settings. 
 

 
 
 

 
 

Copyright © 2001 – 2007 Kayako Infotech Ltd. www.kayako.com 

 

 



  [ 29 ] 
 

Synchronization  

 
 
Synchronization Configuration 
 

• Synchronize data from Outlook to Server – if enabled, data stored in your Outlook 
installation will be uploaded and synchronized to your SupportSuite, eSupport or 
LiveResponse installation.  
 

o Contacts 
 

 Synchronize Contacts - if enabled, contacts added or modified in Outlook will 
be added or modified on your server. 
 

 Delete Contacts – if enabled, contacts deleted in Outlook will also be deleted 
from the server installation. 
 

 Make Contacts Private – if enabled, contacts made private in Outlook will be 
made private to your staff user account in SupportSuite, eSupport or 
LiveResponse. 
 

o Tasks 
 

 Synchronize Tasks - if enabled, tasks added or modified (such as marked as 
complete) in Outlook will be added or modified on your server. 
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 Delete Tasks – if enabled, tasks deleted in Outlook will also be deleted from 
the server installation. 
 

 Make Contacts Tasks – if enabled, tasks made private in Outlook will be 
made private to your staff user account in SupportSuite, eSupport or 
LiveResponse. 
 

o Appointments  
 

 Synchronize Appointments - if enabled, appointments added or modified 
(such as having the date changed) in Outlook will be added or modified on 
your server. 
 

 Delete Appointments – if enabled, appointments deleted in Outlook will also 
be deleted from the server installation. 
 

 Make Contacts Appointments – if enabled, appointments made private in 
Outlook will be made private to your staff user account in SupportSuite, 
eSupport or LiveResponse. 
 

 
• Synchronize data from Server to Outlook - if enabled, data stored in your SupportSuite, 

eSupport or LiveResponse installation will be downloaded and synchronized with your Outlook 
installation. 
 

o Each option following is the same as above, but the reverse (instead of Outlook -> 
Server,  Outlook <- Server). 

 
 
Local Data Deletion  
 

• Prompt when deleting local data – if enabled, you will be prompted to confirm whether or 
not local data (stored in Outlook) should be deleted (if deleted in SupportSuite, eSupport or 
LiveResponse, for example).  

 
 
LiveResponse 
 

• Import contacts into LiveResponse VoIP phone – if enabled, contacts stored in Outlook 
will be copied into the phonebook of the LiveResponse Client Application SIP Addon (the VoIP 
phone module). Only enable this if you have the LiveResponse Client Application installed. 
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Frequently asked questions 
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How can I tell what version of SyncWorks I am running? 

1. Click on the Help menu. 
 

2. Click on the About menu choice.  
 
This will bring up the about box (as shown below) which will detail what version of SyncWorks you 
are running. 
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How do I view the event log? 

Follow the steps outlined here in event logger. 
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Error messages explained 
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Network error messages 

Event logger 

InstaAlert has an integrated event logging system and a log viewer. Most errors (among other 
events) are reported to this log. 
 
To view the event log: 
 

1. Click the Tools menu 
2. Click the Event Log menu choice. 

 
This will bring up a window similar to the following: 
 

 
 

 “The server returned an error response” 

Possible causes: 
 

1. This error is most commonly caused by a 404 Not Found error, a Forbidden error or any 
other HTTP code that is not 200 (the code for “successful”).  

 
Potential solutions: 
 

1. Check you have entered the correct path to your support desk in Options: General. 
2. Check the configuration of your web server (such as folder permissions, .htaccess 

permissions etc.).  

“Unknown error” 

Possible causes: 
 

1. Something has gone very wrong within the internals of InstaAlert. 
 
Potential solutions: 
 

1. Restart the program. If the problem persists, make sure you have the latest stable build of 
InstaAlert (see Getting the latest version). If you do, please contact support. 
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“Received unexpected response from server (invalid header)” 

Possible causes: 
 

1. InstaAlert receives data it does not expect to receive. 
 

2. Your support desk may be “down” and displaying an error message (such as a MySQL error). 
 

3. Your support desk may be displaying a license error. 
 

4. Your support desk may be reporting that the setup directory still exists. 
 
Potential solutions: 
 

1. Ensure you are running the latest stable release of InstaAlert (see Getting the latest version). 
 

2. Ensure your support desk is working properly. 
 
 
 

“The session has expired” 

Possible causes: 
 

1. When InstaAlert logs into your support desk, it creates an active session for your username. 
If this session is deleted or ended for any reason, this error will be generated. 
 

2. A common cause of this error is that more than one copy of InstaAlert is being used to login 
to the same support desk – each one attempting an alternating login that interferes with the 
other’s session. 

 
Potential solutions: 
 

1. Ensure that no more than one copy of InstaAlert is being used to login to your support desk 
with the same username. 

“Failed to connect to server” 

Possible causes: 
 

1. You have entered an invalid host name in your support desk URL. 
 

2. Your server is unavailable. 
 
Potential solutions: 
 

1. Ensure that you have entered the correct support desk host name and URL in the Options: 
General dialog. 
 

2. Check the connectivity of your server. 
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“Connection to the server timed out” 

Possible causes: 
 

1. You have entered an invalid host name in your support desk URL. 
 

2. Your server is unavailable. 
 
Potential solutions: 
 

1. Ensure that you have entered the correct support desk host name and URL in the Options: 
General dialog. 
 

2. Check the connectivity of your server. 
 

“Authentication has failed” 

Possible causes: 
 

1. You have entered the wrong username and password that InstaAlert is attempting to use to 
login to the support desk. 

 
Potential solutions: 
 

1. Ensure that you have entered the correct username and password in the Options: General 
dialog. 

 
 

“HTTP request has failed” 

Possible causes: 
 

1. There was a problem in making the HTTP request to your support desk. 
 
Potential solutions: 
 

1. Restart the program. If the problem persists, restart your machine. If the problem still 
persists, please contact support. 
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Support resources 

If you would like to send in a suggestion or report any errors in this manual, please send an e-mail 
to docs@kayako.com or post in the documentation forum - your input is very much appreciated. 
Please do not use this address for support. 
 
You can obtain further support for any of Kayako’s products via: 
 

• Support desk – www.kayako.com/support 
 

• Community forums – http://forums.kayako.com 
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